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SSEETTTTII NNGG  UUPP  YYOOUURR  CCOOMM PPUUTTEERR  
 

 

 
We recommend that you do this at your earliest convenience, preferably at least a few days before your first 
session. This may take a while on a dialup link, so please allow sufficient time before the first session. 
 
Below are the steps that you will need to follow: 
 

¶ Ensure that you are at the computer on which you will attend your live webinar session and that it is connected to 
the Internet. 

¶ Ensure that you have a headset or microphone and speakers to take full advantage of the audio capabilities 
during the session. 

¶ Ensure that you are an administrator on your computer and can install software. If you are unsure, please contact 
your system administrator. 

 
 
 

SStt ee pp   OOnn ee ::   CCoo nn ff ii gg uu rr ee   &&   VVee rr ii ff yy   tt hh ee   ssyy ss tt ee mm   rr ee qq uu ii rr ee mm ee nn tt ss   
 
To pre-configure a workstation or laptop, access  
 
https://blackboard.secure.force.com/btbb_publichome?dfprod=Collaborate   
 
(this will bring you to the óBehind the Blackboard webpage) and click  follow óFirst Time Userô instructions 
(Figure.1). 

 

 

 
 
Figure. 1 
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Click on Blackboard Collaborate Web Conferencing (Figure. 2). 

 

 
Figure. 2 

 
 
Verify the system requirements by clicking on ósystem requirements for Blackboard Collaborate Web 
Conferencingô (Figure. 3). 
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 Figure. 3 

Check that your system is compatible with Web Conferencing.  (Figure. 4). 

 

 
Figure. 4 

 

  

SSTTEEPP  TTWW OO::   II nn ss tt aa ll ll ii nn gg   BB ll aa cckk bb oo aa rr dd   CCoo ll ll aa bb oo rr aa tt ee   LLaa uu nn cchh ee rr     
 
Once you have confirmed that your system is compatible, use the provided Configuration Room ( Figure. 5) to 
test your connection, download the launcher and configure your audio.  V12.6 Configuration Room (AU-SAS) 
 

 

https://au-sas.bbcollab.com/m.jnlp?sid=zzsupp&password=M.D4EFAAD9AD3169BA81468C4F3141C9&username=Test
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Figure. 5 

 

Blackboard Collaborate will now prompt you to download the Blackboard Collaborate Launcher installer  
 
Select your operating system (Windows or Mac) from the drop-down menu and click Download.  

 

 
 

IInnssttaalllliinngg  tthhee  LLaauunncchheerr  oonn  WWiinnddoowwss  
 
 
Once the download has finished run the Blackboard Collaborate Setup Wizard. Different browsers will handle 
this differently and the behaviour of each browser may vary depending on how you configured your browser 
settings. 
 
Á Firefox prompts you to save the Windows installer BlackboardCollaborateLauncher-Win.msi. Save the file. 

The default save location is your browser's Downloads library. Open the Downloads library and, when the 
download is complete, open the file to run the Blackboard Collaborate setup wizard.  

 

 
 
 
 
 

Á Chrome prompts you to save the Windows installer BlackboardCollaborateLauncher-Win.msi. Save the file. 
The default save location is your Downloads folder. In the bottom left corner of your browser window, Chrome 
shows you the progress of the download. When the download is complete, click on the downloaded file to run 
the Blackboard Collaborate Setup Wizard. 

 

 
 

Á Internet Explorer prompts you to Run or Save the Windows installer BlackboardCollaborateLauncher-
Win.msi. Click Run to run the Blackboard Collaborate Setup Wizard.  
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Click Next to run the setup wizard. 
 

 
 
 

The setup wizard will install the Windows launcher and adds it to the Start menu.  
(Note: Windows 8 or later users can find the launcher on the Start page in Metro view.) 
 
When you have completed running the Blackboard Collaborate Setup Wizard, return to the Downloading Installer page in 
your browser and click óJoinô. 
 

 

 
 

IInnssttaalllliinngg  tthhee  LLaauunncchheerr  oonn  MMaacc  
 
 
When the installer zip file BlackboardCollaborateLauncher-Mac.zip is fully downloaded, unzip the file to install 
the launcher. 
 
Á Safari automatically unzips the file and installs the launcher. No further action is required. 

 
Á In Firefox and Chrome, open the .zip file in your Downloads folder to unzip and install the launcher. 

 
 

Your browser may ask you which application to use to open the .zip file. If so, select the Archive Utility  
(in System/Library/CoreServices). 
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By default, the launcher will reside in the Downloads folder. (When you open your session 
or recording .collab file, you are given the option to move the launcher to your Applications folder.) 
 
 
Now that the launcher is installed, return to the Downloading Installer page in your 
browser and click the óJoinô button. 
 
 

 

  

SSTTEEPP  TTHH RREEEE::  TTee ss tt ii nn gg   &&   CCoo nn ff ii gg uu rr ii nn gg   BB ll aa cckk bb oo aa rr dd   CCoo ll ll aa bb oo rr aa tt ee   

TTeessttiinngg  &&  CCoonnffiigguurriinngg  BBllaacckkbbooaarrdd  CCoollllaabboorraattee  oonn  WWiinnddoowwss  

After you click óJoinô on the Downloading Installer page your .collab file is downloaded.  
It is named one of the following, depending on the type of session: meeting.collab, course.collab or dropin.collab.  
 
Open the .collab file: 
 
 
Á Firefox asks you what to do with the .collab file. Select Open with and then Blackboard 

Collaborate Launcher from the drop-down menu. (If there is no drop-down menu, click  
Choose and open your Downloads folder to select Blackboard Collaborate Launcher.) 
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Á Internet Explorer asks you what to do with the .collab file. Click Open or, if you want to reuse the file later, 
select Save and open. 
 

 

 

Á Chrome presents you with the file at the bottom of your browser window. Click on the file name. 

 

(If you want future session files to open automatically, select Always open files of this type from the menu  and then  
double-click the file name.) 

 

Your session will now open and you will be logged in to the Configuration Session. 
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Please follow the directions displayed on the Whiteboard. 
When the directions have been completed, choose óExitô from the File menu. 
 

TTeessttiinngg  &&  CCoonnffiigguurriinngg  BBllaacckkbbooaarrdd  CCoollllaabboorraattee  oonn  MMaacc 

 
After you click óJoinô on the Downloading Installer page your .collab file is downloaded.  
It is named one of the following, depending on the type of session: meeting.collab, course.collab or dropin.collab.  

 
Open the .collab file: 

 

 
Á Firefox asks you what to do with the .collab file. Select Open with and then Blackboard Collaborate Launcher 

from the drop-down menu. (If there is no drop-down menu, click óChooseô and open your Downloads folder to 
select Blackboard Collaborate Launcher.) 
 

 

 
 

 

 
Á With Safari, open your Downloads folder and then open the .collab file. 

 
 
Á Chrome presents you with the file at the bottom of your browser window. Click on the file name. 

 

 
 

If you want future session files to open automatically, select óAlways open files of 
this typeô from the menu and then double-click the file name. 
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You will be prompted to open the launcher 
 

 

 
 

 
You are prompted to move the launcher to the Applications folder. This is not necessary but doing so will 
help keep your Downloads folder uncluttered. 

 
 

 
 

 

 

 
A Security Warning dialog asks if you want to run this application. Click óRunô. 
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Your session will now open and you will be logged in to the Configuration Session. 
 
 

 
 
 
Please follow the directions displayed on the Whiteboard. 
When the directions have been completed, choose óExitô from the File menu. 
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TTRROOUUBBLL EESSHHOOOOTTII NNGG  

If you are unable to launch Blackboard Collaborate with your .collab file, typically, either your operating 
system does not know what application to use to open this file, you have not installed the launcher or there 
was a problem when you installed the launcher.  

Read the topics below, in order, to troubleshoot your issue.  

1. Confirm the Launcher is Installed  

2. Create a File Association  

3. Clear the Launcher's Java Cache  

4. Reinstall the Launcher  

Note: For helpful articles and FAQs about the launcher, open our Collaborate Knowledge Base and search for 
"launcher".    

 Link: http://blackboard.force.com/apex/publickbsearch?aType=Knowledge&viewAll=Collaborate  

 

11..  CCoonnff ii rrmm  tthhee  LLaauunncchheerr  iiss  IInnssttaall lleedd  

As a first time user, when you open the session or recording link in your browser, you are prompted to 

download the launcher. The string jwsdetect in the URL indicates that the launcher detection process has 

not yet taken place.  

 

When you click Join, Play or Launch Blackboard Collaborate now, you initiate the launcher detection 
process; that is, you are telling the software that you downloaded and installed the launcher. This sets a flag 
in your browser, which will bypass the Downloading Installer page next time you play a recording. 

Caution: Do not click Join, Play or Launch Blackboard Collaborate now until after you have installed the launcher. If 
you do, the detection flag will be set inappropriately. 

However, you may encounter the "first time user experience" (may be prompted to download the launcher) 
even though you installed it earlier.  

You will be treated as a first time user when you open a session or recording link in the following situations: 

Á You cleared your cache and cookies last time you exited your browser. 

Á You use secure/private browsing. 

Á You installed the launcher using one browser but now are launching a session or recording in another 
browser. 

If you see the string launch in the URL, it means you have already gone through the launcher detection 
process. Presuming you actually did install the launcher and have not since uninstalled it, seeing launch in 
the URL indicates that the launcher is installed. 

 

http://blackboard.force.com/apex/publickbsearch?aType=Knowledge&viewAll=Collaborate
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Caution: When sharing a session or recording link with others, do not share links from the address bar of your web 
browser. Use the full (unprocessed) URL you used yourself ï the one shared with you in an email or on a webpage. If 
you share the URL containing the string launch, others will not go through the launcher detection process and, if they 
don't already have the launcher, will not be prompted to download it before obtaining the .collab file.  

To confirm that the launcher is installed, look for the application on your system: 

Á On Windows: The Windows launcher is called Win32Launcher.exe. The default installation location is the 
following directory: 

C:\Users\<username>\AppData\Local\Programs\Blackboard\Blackboard Collaborate Launcher 

Alternatively, look for the application Blackboard Collaborate Launcher in the Control Panel, under Programs 
and Features, or in the Start menu. 

Note: Windows 8 or later users can also find the launcher on the Start page in Metro view. 

Á On Mac: The Mac launcher is called Blackboard Collaborate Launcher. The default installation location is 
your Downloads folder. However, when opening a .collab file, you were given the option to move it to your 
Applications folder instead, so check there too. 

 

22..  CCrreeaattee  aa  FFii llee  AAssssoocciiaatt iioonn  

Your computer may not know what application should be used to open .collab files. Normally, once the launcher is 
installed, the file association between it and .collab files is set automatically. However, if for some reason the 
association was not made, you can make it either through your operating system or, if a Firefox user, through your 
browser.  

Operating System 

For instructions on making the file association through your operating system, open our Collaborate Knowledge 
Base and search for "file associations". 

Link: http://blackboard.force.com/apex/publickbsearch?aType=Knowledge&viewAll=Collaborate  

 

FFIIRREEFFOOXX    

Windows 

 

Create the file association through your Firefox Options.  

1. From the Tools menu, select Options and then the Applications tab.  

2. For the Content Type Blackboard Collaborate Session, select the Action Use other.. 

3. In the Select Helper Application dialog, select Blackboard Collaborate Launcher.  

http://blackboard.force.com/apex/publickbsearch?aType=Knowledge&viewAll=Collaborate


 

EIT_eLearning_BlackboardCollaborate_Instructions_v6                   Last Edited  March 2016 

 

MMAACC  

Create the file association through your Firefox Preferences.  

1. From the Firefox menu, select Preferences and then the Applications tab.  

2. For the Content Type collab file, select the Action Use other... 

3. In the Select Helper Application dialog, select Blackboard Collaborate Launcher.  
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33..  CClleeaarr  tthhee  LLaauunncchheerr''ss  JJaavvaa  CCaacchhee  

If the launcher is installed and the file association set correctly but you are still having problems launching 
your .collab file, try clearing the launcher's Java cache.  

1. Open the launcher application. 

2. Open the Advanced tab and click Clear Cache. 

 

 

44..    RReeiinnssttaall ll   tthhee  LLaauunncchheerr  

If you are still having issues, uninstall and reinstall the launcher.  

a. Uninstall Current Installation 

Before you reinstall the launcher, uninstall the current instance of the installer as you would any other 
application: 

Á On Windows, open Programs and Features in your Control Panel and uninstall Blackboard 
Collaborate Launcher. 

Á On Mac, open your Downloads folder (or Applications folder if you put the launcher application 
there) and drag Blackboard Collaborate Launcher to your Trash.  

Mac Note: If you are having difficulty with the launcher installation process, see the Collaborate Knowledge 
Base article, Setting Mac OS X File Associations to open Blackboard Collaborate Launcher.zip files. 

Link: http://blackboard.force.com/apex/publickbarticleview?id=kA770000000CbGS  

 

b.  Install the Launcher following the instructions previously provided in this document 

 
 
 
 

 

http://blackboard.force.com/apex/publickbarticleview?id=kA770000000CbGS
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HHOOWW  TTOO  CCOONNTTAACCTT  BBLL AACCKK BBOOAARRDD  CCOOLL LL AABBOORRAATTEE  

TTEECCHHNNII CCAALL   SSUUPPPPOORRTT??  

 https://blackboard.secure.force.com/btbb_publichome   

(Available 24 Hours / Day  - 7 Days / Week) 

Blackboard Collaborate provides different methods in which to contact our Technical Support team, 
all of which you may find below.  We've listed them in order of preference to ensure a timely and 
proper response. 

 

 

CCRREEAATTEE  AA  CCAASSEE 

Provides an electronic form that allows you to enter key information about your question 

that allows the Technical Support team to provide an appropriate response.  It also 

allows for immediate routing of your question to the appropriate team responsible for the 

category you select. 

    

CCHHAATT  WWIITTHH  AANN  AAGGEENNTT  

Provides the ability to chat with a Tier 1 Technical Support Representative for a response 

to your questions.   

 
 
    

    

BBLLAACCKKBBOOAARRDD  CCOOLLLLAABBOORRAATTEE  SSUUPPPPOORRTT  PPHHOONNEE  NNUUMMBBEERRSS  

Occasionally you may wish to speak with a Client Support Representative on the phone.  

The Technical Support Team is available by different numbers worldwide, depending on 

your current location.  These numbers are answered by a live agent 24x7x365.   

 

Use the following link to find out the appropriate support number 

https://blackboard.secure.force.com/apex/publickbarticleview?id=kA570000000PCje 

 

 
 

FOR ANY OTHER QUERIES PLEASE CONTACT YOUR NEAREST EIT OFFICE.  
 

CONTACT DETAILS ARE AVAILABLE ON OUR WEBSITE: www.eit.edu.au  

 

 

 

 

 
 

http://blackboard.force.com/btbb_publichome?dfprod=Collaboratebehind.blackboard.com
https://blackboard.secure.force.com/apex/publickbarticleview?id=kA570000000PCje
http://www.eit.edu.au/
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BBLL AACCKK BBOOAARRDD  CCOOLL LL AABBOORRAATTEE  ÊÊ  MM OOBBII LL EE  AAPPPPLL II CCAATTII OONN    
 

 

 

Blackboard Collaborate Mobile Web Conferencing is designed for active learners who are 
on the go. 

**Please note you can NNOOTT view webinar recordings with your device** 

**You can only attend the live webinar sessions using the App** 

Session attendees can participate in live web conferencing sessions from the following 
devices; 

Mobile (iOS) Mobile (Android) 

Requires iOS 4.3 or later. 
 

Compatible with iPhone, iPad and iPad 
touch. 

Requires Android 2.3.3 and up 

**Also Available on Kindle Fire HD Tablet 

You can download the free app at the following app stores (dependant on your device) 

 

Participants using the Blackboard Collaborate Mobile app, will be able to: 

Å View whiteboard content, including images, presentations and annotations 

Å View shared applications and desktops 

Å Communicate with moderators and other participants via text chat and two-way audio 

Å Respond to yes/no and multiple-choice polling questions 

Å Raise their virtual hand for questions or comments 

Å Use emotions to indicate laughter, confusion, or approval 

Å View the names, polling responses, and emoticons of other session members 

 

 

http://itunes.com/apps/blackboardcollaboratemobile
http://itunes.com/apps/blackboardcollaboratemobile
http://www.amazon.com/gp/product/B00CH9J1J8?ie=UTF8&ref=mas_dl
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BBLL AACCKK BBOOAARRDD  CCOOLL LL AABBOORRAATTEE  ÊÊ  MM OOBBII LL EE  AAPPPPLL II CCAATTII OONN    

RREEFFEERREENNCCEE  GGUUII DDEE  

  

  

JJooiinniinngg  aa  MMoobbii llee  WWeebb  CCoonnffeerreenncciinngg  SSeessssiioonn::    

  

The first step in joining a Mobile web conferencing session is to visit the appropriate App 
Store and download the application.  

Once the app is installed on your device, the application icon  will appear.  

1. To start the web conferencing session:  

¶ Tap the app to open.  

¶ You may receive a security message, similar to the one shown below.  

¶ Please make sure you click óAcceptô. 
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2. Copy the webinar room link from your Moodle course page and paste that link into the 
óBlackboard Collaborate Session URLô area. 

 

 

 

 
 
 

3. Enter your full name. 
 

This information is very important as it is how the course coordinator will correctly identify you 
when marking attendance. 

 

 

 

 



UUnnddeerrssttaannddiinngg  tthhee  MMoobbii llee  LLaayyoouutt   

 



UUnnddeerrssttaannddiinngg  tthhee  TTaabblleett  LLaayyoouutt   

  

 



TThhee  PPaarr tt iicciippaanntt  LLiisstt   

 

On a tablet, the Participants List will be displayed by default and is only hidden when the 
Content area is expanded into full screen.  
On the phone, the Participants List is hidden by default.  
 
To open the Participants List:  
 

Á Tap the  icon to open and close the list.  
 

 
 

 

 

Understanding the List:  
 

 

 
 

Á Tammy has her hand raised.  
 

 
Á Stacy is using an emoticon.  

 
 

Á Bobby has stepped away from 
the session.  

 

 

  


